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New Project Screen

* On starting Project a blank template will appear.

‘& Microsoft Project - Project1
‘ File Edit Yiew Insert Format Tools Project Window Help E_Jl(_]
DEE ERY y2RY ~ @ =i B ¢ 6 Moo R @ 3.
|4 B % = show~ Al -8 + B I U ]%EE All Tasks - K,
Task Name Duration Jul 18,'04 Jul 25, '04 Aug1,'04 Aug 8,'04 15,'04 Aug 22,'04 Aug29,'04 A
| WITIFIS|SIMITIWITIFIS|S MIT WITIFIS S IM|T WITIF]s SIMITIWITIFIS SIMITIWITIFIS SIM|TWITIFS s MIT W]
|
Al »
Ready f /

LSU 07/26/2004 MS Project Example



Basic Project Information

* From the “Project” menu select “Project Information” and
enter the anticipated project start date.

Project Information for ‘Project1’

Start date: [MEE

Finish date: | Mon 7/26]04

Lo Lel Ll

Schedule from: |Pr0ject Start Date

All tasks begin as soon as possible,

Current date: |Mon 7126/04

Lol Lo Lo

Status date:  |NA
Calendar: | standard
Priority: [s00 =
Hep | statistics.. | [ ok Cancel |
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Enter the major tasks

* Type in the major tasks (WBS level 1) in the “Task Name” box.
 Each row is a separate task

* Do not worry about the rest of the columns for now

'& Microsoft Project - Project1

File Edit View Insert Format Tools Project Window Help QJEJ
p Show » } 1

¥+ Data archive U

: = o Task Name Duration Start Finish Predecessors Ri3,'05 Jan 23, '05 Jan 30, '05 Feb 6,'05 -
_ _ | _ | | [Tw]T]F]s Twlt[Fls|sM[Tw[T[F[s[sm]|T w[T[F ]S
1 Powver System 1day? Mon1/2405 Mon 1/24/05
Calendat 2 Flight Control Unit 1 day? Mon1/24/05 Mon 172405
== IDala Archive U |

e

 NUM
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Insert Rows

* Select the row above which you want to insert a subunit
* Select “New Task” from the “Insert” menu

* To delete a row, select the row and press the “Delete” key
'& Microsoft Project - Project1 @@@

@ File Edit Yiew Insert Format Tools Project Window Help i’il
DEESRAY IRABY v @ okit @06 waw | QQAPT @ 7).
€ » & = show~ Arial 8 v B I U == = | alTasks v KL
o Task Name Duration Start Finish Predecessors |Ri Jan 23, '0S | Jan 30,'05 Feh 6,'05 Fi &
@ | | s fwiT[Fls|sIM[TIwiT[FlIs|sM|TIW[T]FIs]|S
= 1 Powver System 1day? Mon1/24005 Mon 1/24/05

B

i

Flight Control Unit 1 day? Mon 12405 Mon 1/24005

9 Data Archive Unit 1day? Mon1/24005 Mon 1/24/05
10 Data Archive Disk 1day? Mon1/24005 Mon 1/24/05
11 Auxiliary Transmitter 1day? Mon 12405 Mon 1/2405
12 Mechanical Structure 1 day? Mon1/24005 Mon 1/24/05
13 Thermal Control 1day? Mon1/24005 Mon 1/24/05
= 14 System Integration & Test 1day? Mon1/2405 Mon 1/24/05
= 15 Management 1 day? Mon 1724005 Mon 1/24/05
|
S P slld f
Ready MUM
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Enter the subunit task names

* Type in the name of the subunit task in the “Task Name” field
e Subunits are “indented” with the right arrow on the task bar

 When subunits are so “indented” the major unit will become
bold and the Gantt chart bar will change shape

‘& Microsoft Project - Project1

@ File Edit Yiew Insert Format Tools Project Window Help

8] x|

DEE SRY $BART v @ =it @ ¢ @ Noow eer @@,
4@ » & = show~ Al ~8 B I U EE = AlTasks - V=N,
Inteqgrate & Test
(i} Task Name Duration Start Finish Predecessors  |Ri Jan 23,'05 | Jan 30,'05 Feh 6, '05 Fi «
, _ , sMITWITIFs[sM[TIWI[T[F[s[sIMITWI[T[F]s[s™]
1 -I Power System 1day? Mon 1/24/05 Mon 1/24/05
nd 2 Powver Source 1day? Mon1/24/05 Mon 1/24/05
= 3 FCU Supply 1day? Mon1/24/05 Mon 1/24/05
= 4 DAUHD Supply 1 day? Mon1/2405 Mon 1/24/05
t 5 DAU Supply 1 day? Mon1/2405 Mon 1/2405
5] CubeSat Supply 1day? Mon1/24005 Mon 1/24/05
7 Integrate & Test 1day? Mon1/24/05 Mon 1/24/05
8 Flight Control Unit 1day? Mon1/24/05 Mon 1/24/05
9 Data Archive Unit 1day? Mon1/24005 Mon 1/24/05
10 Data Archive Disk 1 day? Mon1/2405 Mon 1/24005
1" Auxiliary Transmitter 1day? Mon1/2405 Mon 1/24/05
12 Mechanical Structure 1day? Mon1/24005 Mon 1/24/05
13 Thermal Control 1day? Mon1/2405 Mon 1/24/05
a— 14 System Integration & Test 1day? Mon1/2405 Mon 1/24/05
T 15 Management 1 day? Mon1/24005 Mon 1/24/05
k ‘ =
| BT il oo f‘
Ready MUM
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Complete entering WBS

* Process of inserting rows, typing in the task name and

indenting the subunit continues until all tasks in the WBS are
e nte & ;Aicrosoft Project - Project1

Ready

File Edit View Insert Format Tools Project MWindow Help EJ!J

DEelE Ry BRI v @ =¢ B & @& | NoGroup - RAQP | @[3,

€ % & = show~ Aral -8 v B I U = = | Al Tasks - 7= N,

(5 ) Task Name Duration Start Finish F Jan 23,'05 | Jan 30, '05 |FehB,'05 =
| | | sMITIw[T[FIs|s[M[TIw[T[F[s|[s[MIT Iw

1 [=| Power System 1day? Mon 1/24/05 Mon 1/24/05 L o J
2 Power Source 1day? Mon1/2405 Mon 1/24105 ]
3 FCU Supply 1day? Mon1/2405 Mon 1724105 ]
4 DAUHD Supply 1day? Mon1/24005 Mon 1724105 BER
5 DAU Supply 1day? Mon 12405  Mon 1/24105 i
] [=] CubeSat Supply 1day? Mon 1/24/05 Mon 1/24/05 -
7 Interface to power source 1day? Mon1/2405 Mon 1/24/05 i)
8 =/ FCU Control Interface 1day? Mon 1/24/05 Mon 1/24/05 l o 4
9 Establish Cortrol Requirements 1day? Mon1/2405 Mon 1/24/05 B
10 Design control interface 1day? Mon1/2405  Mon 1/24/05 i)
11 Prototype & test design 1day? Mon1/24005 Mon 1724105 B
12 Complete design 1day? Mon1/2405 Mon 1/24/005 ]
13 Implement & test desian 1day? Mon 12405 Mon 1/24005 B
14 DC/DC Converters 1day? Mon 124005 Mon 1/24/05 ]
15 FCU Monitoring Interface 1day? Mon1/24005  Mon 1724105 i)
16 Integrate & Test 1day? Mon1/2405 Mon 1/24005 ]
17 Flight Control Unit 1day? Mon1/2405 Mon 1/24005 B
18 Data Archive Unit 1day? Mon 124005 Mon 1/24/05 B

m- 18 Data Archive Disk 1day? Mon1/2405 Mon 1/24105 B

RESOUrCE 20 Auxiliary Transmitter 1day? Mon1/2405  Mon 1/24/05 i)
21 Mechanical Structure 1day? Mon1/2405 Mon 1/24005 ]
22 Thermal Control 1day? Mon 124005 Mon 1/24/05 ]
23 System Integration & Test 1day? Mon1/2405 Mon 1/24/005 B
24 Management 1day? Mon1/2405 Mon 1/24/05

MNUM
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Display the WBS code

* Select the “Information” column, right click and choose “Hide
Column”.

* Next select the “Task Name” column and from the “Insert”
menu select “Column”. The following pop-up will appear.

e Choose “WBS” as the “Field name”

Column Definition @
Field neme: | -~ Ok
C F

. VA
Title: - Cancel
- |'WBS Predecessors .
Align title:} yec 5, ccessors Best Fit
S Work
Align data Work Contour __J
Work Variance v
Width: et
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Showing the WBS code

* The correct WBS code number will now be displayed for all
tasks

‘& Microsoft Project - Project1

File Edit Yiew Insert Format Tools Project Window Help ﬂ LI
DEE &ERY BT v @ =& € | MoGrowp R @ 3.
€ 9 & = Show~ Arial -8 v B ZI U All Tasks
1
WBS Task Name Duration Start Finish Jan 23,'05 Jan 30, '05 Feh 6, '05 Fa
| | slsm[Tiwl[T[F[s|sM[Tw[T[F[S sTMMWh]F!ss:J
1 I:] Power System 1day? Mon 124105 Mon 1/24/05 vy
2 11 Power Source 1day? Mon1/2405 Mon 1/24105 B
3 12 FCU Supply 1day? Mon1/24/005 Mon 1/24/05 B
4 1.3 DAUHD Supply 1day? Mon1/24005 Mon 1/24/05 ]
= 14 DAU Supply 1day? Mon1/24/05  Mon 1/24/05 i)
6 1.5 =] CubeSat Supply 1day? Mon 1/24/05 Mon 1/24/05 L o ]
7 151 Interface to povwer source 1day? Mon1/24005 Mon 1/24/05 B
8 1.5.2 [=l FCU Control Interface 1day? Mon 1/24/05 Mon 1/24/05 l o
9 | 15241 Establish Control Requirements 1 day? Mon 1/2405  Mon 172405 B
10 1522 Design control interface 1day? Mon1/24005 Mon 1/24/05 i)
11 1523 Protatype & test design 1 day? Mon 1/2405  Mon 1/24/105 B
12 1524 Complete design 1day? Mon1/24005 Mon 1/24/05 i)
13 1525 Implement & test design 1day? Mon1/24005 Mon 1/24/05 B
14 153 DC/DC Converters 1day? Mon1/2405 Mon 1/2405 B
15 154 FCU Monitoring Interface 1day? Mon1/2405 Mon 1/24/05 B
16 Integrate & Test 1day? Mon1/24/05 Mon 1/24/05 B
2 Flight Cortrol Unit 1 day? Mon 1/2405  Mon 1/2405 BEa
3 Data Archive Unit 1day? Mon1/2405 Mon 1/24005 B
4 Data Archive Disk 1day? Mon 12405 Mon 1/24/05 B
5 Auxiliary Transmitter 1 day? Mon 1/2405  Mon 1724105 B
6 Mechanical Structure 1day? Mon 124005 Mon 1/24/05 BEa
7 Thermal Control 1day? Mon1/24005 Mon 1/24/05 i)
8 System Integration & Test 1day? Mon1/24/05 Mon 1/24/05 B
9 Management 1day? Mon1/24/05 Mon 1/24/05 i) =
slsf o fl
: NUM |5
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Task bars

e With all subunits inserted the lowest level will be blue
rectangles and higher levels will be black bars with points on
the ends.

Microsoft Project - Project1 @

@ File Edit View Insert Format Tools Project Window Help g_l_xJ
Dl gk¥ &E@ng@@m E & €&  NoGroup - R a@-
€ B & = Show-~ Aral +8 v B ZI U All Tasks - 7= N
Power Source
WBS | Task Name Duration Start Finish | Jan 23,'05 Jan 30,'05 |Feh B,'05 |F o
sisMITwlT[Fs[sMTw[T[F[s[sM|TIw[T[F[s]s
2 14| [+ Power Source | 1day? Mon172405 Mon 172405 [ B
4 1.2 [+ FCU Supply 1day? Mon 1/24/05 Mon 1/24/05 l o J
3 13 # DAU HD Supply 1day? Mon 124005 Mon 1/24/05 =
g 1.4 + DAU Supply 1day? Mon 124/05 Mon 1/24/05 L o ]
10 1.5 = CubeSat Supply 1day? Mon 1/24/05 Mon 1/24/05 L o 4
11 1.51 [#/ Interface to power source 1day? Mon 1/24/05 Mon 1/24/05 L o ]
13 1.5.2 [= FCU Control Interface 1day? Mon 1/24/05 Mon 1/24/05 l o J
14 1521 Establish Control Requirements 1day? Mon1/24005 Mon 1/24/05 B
15 1522 Design control interface 1day? Mon1/2405 Mon 1/24005 B
16 1523 Prototype & test design 1day? Mon1/24005 Mon 1/24/05 B
17 1524 Complete design 1day? Mon1/2405 Mon 1/24005 B
18 1525 Implement & test design 1day? Mon1/24005 Mon 1/24/05 B
19 1.5.3 [+ DC/DC Converters 1day? Mon 1/24/05 Mon 1/24/05 L o J
21 1.5.4 [#] FCU Monitoring Interface 1day? Mon 1/24/05 Mon 1/24/05 o 4
23 1.6 [# Integrate & Test 1day? Mon 1/24/05 Mon 1/24/05 L o 4
Trac 25 2 [# Flight Control Unit 1day? Mon 1/24/05 Mon 1/24/05 L )
an 27 3 [# Data Archive Unit 1day? Mon 1/24/05 Mon 1/24/05 l o J
29 4 [+ Data Archive Disk 1day? Mon 1/24/05 Mon 1/24/05 o J
m- 3 5 [# Auxiliary Transmitter 1day? Mon 1/24/05 Mon 1/24/05 L o 4
h € 33 6 [+ Mechanical Structure 1day? Mon 1/24/05 Mon 1/24/05 l o J
g 35 7 [# Thermal Control 1day? Mon 1/24/05 Mon 1/24/05 o J
37 8 [+ System Integration & Test 1day? Mon 1/24/05 Mon 1/24/05 L o
7 » 39 9 ¥l Management 1day? Mon 1/24/05 Mon 1/24/05 | o 4
‘v
o] | sl o ﬁ
Ready NUM
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Distinguishing different levels

* You can change the color of the task bar to distinguish between
the different levels in your WBS

» Select the task bar to change (in the Gantt chart area), right
click and select “Format Bar”.

* Change the color of the “Start”, “Middle” and “End”
Format Bar @@

Bar Shape ] Bar Text ]

Start Middle End

§hape: | . v| Shage: | e :I Shapg: | ' vl
Type: |Solid v] Pattern: |_ :J Type: |Solid v]
Color: |. Black vI Calor: Color: I. Black vl

Sample: B Red
[ vellow
FI:I Lime
[ aqua
B clue
B Fuchsia

Help ] white | OK l Cancel

B Maroon
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Results after task bar change

* The results of changing the task bar color are shown below

‘& Microsoft Project - Project1

Ready

UM

File Edit Yiew Insert Format Tools Project Window Help il!]
DR ey saae @ = b €&  noGrowp - R @ 3.
4@ % & = Show~ | Aril ~-8 + B I U = = | All Tasks v N
: : WBS Task Name Duration Start Finish Jan 23, '05 Jan 30,'05 Feb 6,'05 F a
| | | sism[Tw[T[F[s[sM[Tw[T[F]s[sm|[TwW[T[F[S s:
1 1 =l Power System 1day? Mon 1/24/05 Mon 1/24/05 =y
Calendat 2 11 [+ Power Source 1day? Mon 1/24/05 Mon 1/24/05 =y
l — 4 1.2 [+ FCU Supply 1day? Mon 1/24/05 Mon 1/24/05 =
6 1.3 I+/ DAU HD Supply 1day? Mon 1/24/05 Mon 1/24/05 —
Gant 8 1.4 ¥ DAU Supply 1day? Mon 12405 Mon 1724/05 ]
S 10 1.5 =/ CubeSat Supply 1day? Mon 1/24/05 Mon 1/24/05 TP
11 1.5.1 # Interface to power source 1day? Mon 1/24/05 Mon 1/24/05
" 13 1.5.2 [=] FCU Control Interface 1day? Mon 1/24/05 Mon 1/24/05
A 14 1521 Establish Control Requirements 1day? Mon1/2405 Mon 1/2405
15 1522 Design control interface 1 day? Mon1/24/05 Mon 172405
16 1523 Prototype & test design 1day? Mon1/2405 Mon 1/24/05
17 1524 Complete design 1 day? Mon 1/24/05  Mon 1/24105
18 1525 Implement & test design 1day? Mon1/24/05 Mon 1/2405
19 1.5.3 [+ DC/DC Converters 1day? Mon 1/24/05 Mon 1/24/05
21 1.5.4 [#] FCU Monitoring Interface 1day? Mon 1/24/05 Mon 1/24/05
23 1.6 [+ Integrate & Test 1day? Mon 1/24/05 Mon 1/24/05 vy
25 2 [+ Flight Control Unit 1day? Mon 1/24/05 Mon 1/24/05 =y
3 [+ Data Archive Unit 1day? Mon 1/24/05 Mon 1/24/05 ey
4 ¥ Data Archive Disk 1day? Mon 17224105 Mon 1/24/05 L o 4
5 [+ Auxiliary Transmitter 1day? Mon 1/24/05 Mon 1/24/05 L o
6 [# Mechanical Structure 1day? Mon 124005 Mon 1/24/05 L o 4
7 [# Thermal Control 1day? Mon 1/24/05 Mon 1/24/05 L o
8 [+ System Integration & Test 1day? Mon 1/24/05 Mon 1/24/05 L o 4
9 [+ Management 1day? Mon 1/24/05 Mon 1/24/05 L o 4 <
' : s =
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Set the task durations

e Now enter the time associated with each task in the “Duration”
field. See the MS Project Help for choices on units.

e Set durations for the lowest level tasks and the total time will
be summarized or rolled-up to the next highest level.

pp EIBX

crosoft Project - Example Projec

File Edit View Insert Format Tools Project Window Help QJE
DEE &SGRV $BBRBIC v @ =& B ¢ @ hodroup Ry @@,
€ 9 % = show~ Al ~8 v B I U All Tasks -7 AL
System Integration & Test
WBS Task Name Duration Start Finish Predecessors | Re Jan 23, '05 Jan 30, '05 |Feh B,'05 |Feh 13,'05 &
SIS MITMWITIF[S|SMIT MWITIFS (S MIT WWITIFIS (S MIT W
il 1 =l Power System 10 days Mon 1/24/05 Fri 2/4/05 3
2 11 [+/ Power Source 5days Mon 1/24/05 Fri 1/28/05
4 1.2 + FCU Supply 10 days Mon 124/05 Fri 2/4/05 v
B 1.3 # DAU HD Supply 5 days Mon 1/24/05 Fri 1/28/05
8 14 [# DAU Supply 10 days Mon 1/24/05 Fri 2/4/05 Vv
10 15 (=] CubeSat Supply 4days Mon 124/05 Thu 1227/05
11 1.5.1 + Interface to power source 2days Mon 124/05 Tue 1/25/05
13 1.5.2 =] FCU Control Interface 4days Mon 1224/05 Thu1.227/05
14 15241 Establish Control Requirements 1day Mon1/24005 Mon 1/24005
15 1522 Design control interface 2days  Mon1/2405  Tue 172505
16 1523 Prototype & test design 4days  Mon1/2405  Thu1/27/05
17 1524 Complete design 1day Mon1/24005 Mon 1/24005
18 1525 Implement & test design 2days  Mon 1/2405  Tue 1/25/05
19 153 ¥/ DC/DC Converters 3days Mon 124105 Wed 1/26/05
21 1.5.4 + FCU Monitoring Interface 3days Mon 124005 Wed 1/26/05
23 1.6 Integrate & Test 3days Mon 124105 Wed 1/26/05
25 2 [# Flight Control Unit 10 days Mon 1/24/05 Fri 2/4/05 2 4
27 3 Data Archive Unit 10 days Mon 1/24/05 Fri 2/4/05 4
m 29 4 [# Data Archive Disk 3days Mon 124105 Wed 1/26/05
3 5 [+ Auxiliary Transmitter 5days Mon 1/24/05 Fri 1/28/05
33 6 [#/ Mechanical Structure 10 days Mon 1/24/05 Fri 2/4/05 . 4
35 7 [# Thermal Control 5days Mon 1/24/05 Fri 1/28/05
37 8|+ System Integration & Test | 6days Mon 12405 Mon 1/31/05
39 9 [+ Management 50 days Mon 1/24/05 Fri 41/05 v
=il | Ll:l
Ready NUM
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Set the task predecessors

* Enter the task dependence (i.e. which tasks must be complete
prior to starting the next task) in the “Predecessors” field.

You need to use the row number, not the WBS code.

File Edit View Insert Format Tools Project Window Help
D2 HERY B v @ =i @ e @) Moo ey e,
4 % 4 = show~ | Al ~8 v B ZI U All Tasks - KL
WBS Task Name Duration Start Finish Predecessors  |Re | Jan 23,'05 | Jan 30, '05 |Feb6,'0 ~
. | FlSIS\MITIWIT(FLSIS\MITIWIT{FlSISWﬁj
1 1 =l Power System 10 days Mon 1/24/05 Fri 2/4/05 L ,
7) 11 [+ Power Source 5days Mon 1/24/05  Fri1/28/05 e 4
4 1.2 [* FCU Supply 10 days Mon 1/24/05 Fri 2/4/05 ¥ 7
- 6 1.3 DAU HD Supply 5days Mon 1/24/05 Fri 1/28/05 P
] 14 [# DAU Supply 10 days Mon 1/24/05 Fri 2/4/05 G %
10 1.5 [= CubeSat Supply 10 days Mon 1/24/05 Fri 2/4/05 i Z
1" 1.5.1 +l Interface to power source 2days Mon 124105 Tue 1/25/05
13 1.5.2 =/ FCU Control Interface 10 days Mon 1/24/05 Fri 2/4/05
14 1521 Establish Control Requirements 1day Mon1/2405 Mon 124005
15 1522 Design control interface 2days  Tue1/2505 Wed 1/26/05 14
16 1523 Prototype & test design 4days  Thu1/2705 Tue 2105 15
17 1524 Complete design 1day Wed 2205  Wed 22005 16
18 1525 Implement & test design 2 days Thu 23105 Fri 24005 17
19 153 # DC/DC Converters 3days Mon 12405 Wed 1rzsm5:|
21 1.5.4 + FCU Monitoring Interface 3days Mon 1/24/05 Wed 1/26/05 T
23 1.6 [+ Integrate & Test 3days Mon 1/24/05 Wed 1/26/05 p—
25 2 [# Flight Control Unit 10 days Mon 1/24/05 Fri 2/4/05 F X3
27 3 [# Data Archive Unit 10 days Mon 1/24/05 Fri 2/4/05 4 4
m 29 4 [+ Data Archive Disk 3days Mon 124105 Wed 1/26/05 P—
Re 3 5 [# Auxiliary Transmitter 5days Mon1/24/05  Fri1/28/05 PE—
33 6 [+ Mechanical Structure 10 days Mon 1/24/05 Fri 2/4/05 L 4 s
35 7 [# Thermal Control 5days Mon 1/24/05 Fri 1/28/05 PE———
37 8 [+l System Integration & Test 6 days Mon 1/24/05 Mon 1/31/05 P
39 9 [+l Management 50 days Mon 1/24/05 Fri 41/05 L 4
v
| ET 3[R fl
Ready
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Enter all predecessors

* Here all the task predecessors are determined and entered, but the Gantt
chart now needs room to display fully

File Edit View Insert Format Tools Project ‘Window Help illl
R " | é[}.”\k}/ &E*«gng@a ‘:E!@‘@NoGroup .QQ@! ﬁ@.
€ D &+ = Show~ Aral +38 v B I U All Tasks > v N
Flight Control Unit
Task Name Duration Start Finish Predecessors |Resource 227,'05 Mar 6, '05 [Mar 13,'05 Mar 20, '05 Mar 27, '05 Apr 3,'05 -
L | | mlTiwlTlF[s[smTiwlTIFIs[sim[Tiwl[TIFIs[sim[TiwlTIF[s[sIm[TIwlTIF]s s M[TIw[TIF]S j
1 =l Power System 51 days Mon 1/24/05 Mon 4/4/05 . 4
2 Power Source 5days Mon 1/24/05 Fri 1/28/05
4 [+ FCU Supply 10 days Mon 1/31/05 Fri 2111/05
3 [# DAU HD Supply 5days Mon214/05  Fri 218/05
4 g [+ DAU Supply 10 days Mon 2/21/05 Fri 3/4/05 e
10 [ CubeSat Supply 18days Mon 3/7/05 Wed 3/30/05 w P
11 [# Interface to power source 2days Mon3/7/05 Tue 3/8/05
13 [= FCU Control Interface 10 days  Wed 3/9/05 Tue 3/22/05
14 Establish Control Requirements 1day  Wed3/9/05  Wed 3905 12
15 Design control interface 2days  Thu 31005 Fri31105 14
16 Prototype & test design 4days Mon3M405 Thu3HM705 15
17 Complete design 1 day Fri 31805 Fri 3118105 16
18 Implement & test design 2days  Mon3/2105  Tue 3/22/05 17
19 [+ DC/DC Converters 3days Wed 3/23/05 Fri 3/25/05
21 [#] FCU Monitoring Interface 3days Mon 3/28/05 Wed 3/30/05
23 [+ Integrate & Test 3days Thu3/31/05 Mon 4/4/05 e P
25 |+ Flight Control Unit I 10 days Mon 2/14/05 Fri 2/25/05
| 27 [+l Data Archive Unit 10 days  Mon 3/7/05 Fri 318/05 4 . 4
m' 28 |[# Data Archive Disk 3days Mon 32105 Wed 3/23/05 P—
L 31 | # Auxiliary Transmitter 5days Thu 3/24/05 Wed 3/30/05 PEEEEE—
[#/ Mechanical Structure 10 days Tue 4/5/05 Mon 4/18/05 P
[+ Thermal Control 5days Tue 419/05 Mon 4/25/05
[+ System Integration & Test 6 days Tue 4/26/05 Tue 5/3/05
*/ Management 100 days Mon 1/24/05 Fri 6/110/05 o
J3 | K5 L H:I
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Set the timescale of the chart

. From the “Format” menu select “Timescale”
. Set the Major Scale to Months
. Set the Minor Scale to Weeks

Timescale @ Timescale @
Timescale I Nonworking Time Timescale I Nonworking Time I
Major scale Major scale
Units: v  Label: IJan 30, '00 j IV Use Fiscal Year Units: |M0nths v| Label: |January :I IV Use Fiscal Year
Years . ey
3 ian v Tick li |1 - ian: v
Count: Half Years Align: |Left VI IV Tick lines Count: | j align: |Left i d IV Tick lines
Minor scale| Quarters Minor scale
Months ) )
its: [ : ¥ its: : ¥
Units: (i 2o Months Label |S, M, T, j IV Use Fiscal Year Units:  [[EETS v Label Is, M, T, L] IV Use Fiscal Year
Count: |Weeks align: v Tick|i Count; |VEars Align: | v Tick i
ol Days 19 Center v v ick lines ol HolF Years ig Center v v ick lines
General | Haurs General —|Quarters
Size:  |Minutes [V Scale separator Sipg;  |Menths V' Scale separator
= - = Thirds of Months
Preview Preview — RUEES
s Feb 27, 05 Mar 6, '05 Mar 13, 05 Mar 20,05 Mal Engs
wlT[Fls|sM[Tw[T[FlsismMITW[TIF[s[sM[Tw[TIF[s[sM[Tw[T[F]s]|s] W]T|F|Minutes [slsM[Tiw[TIFls]sIM[TIw[T[F[s]sIM[T wlT[F[s[s]
MNone
OK I Cancel l OK I Cancel l
LSU 07/26/2004 MS Project Example 16




After timescale change

 Now the full Gantt chart from project start to end can be displayed

‘& Microsoft Project - Example Project.mpp

File Edit View Insert Format Tools Project Window Help & x|
DEESGRY $BRAY @ G oo - RAT @@,
€ 9 & = Show~ Arial v 8 = | All Tasks - v KL
Management
Task Name Duration Start Finish Pred | February | March | April Ma -
| | 116 [1/23 [1/30 [ 28 [2n3 [2r20 [2/27 [ 3/ [313 [3720 [327 [ 413 [4110 [4n17 [4R24 | 51 s.:l
1 | Power System 51days Mon 1/24/05 Mon 4/4/05 L
2 [+ Power Source 5days Mon1/24/05  Fri1/28/05 T
4 # FCU Supply 10days Mon1/31/05  Fri 21105 G
6 +| DAU HD Supply 5days Mon 2/14/05 Fri 218/05 —
8 [+ DAU Supply 10 days Mon 2/21/05 Fri 3/4/05 P——
10 | =] CubeSat Supply 18days Mon 3/7/05 Wed 3/30/05 e
11 [# Interface to power source 2days Mon3/7/05 Tue 3/8/05
13 [=] FCU Control Interface 10 days Wed 3/9/05 Tue 3/22/05
14 | Establish Control Requirements 1day  Wed 3805  Wed 3/8/05 12
15 Design control interface 2days  Thu 31005 Fri3M1/05 14
16 | Protatype & test design 4days  Mon3M405 Thu3M705 15
17 Complete design 1 day Fri 318105 Fri 318105 16
18 Implement & test design 2days Mon 3/2105  Tue 3722005 17
19 | [+ DC/DC Converters 3days Wed 3/23/05 Fri 3/25/05
21 [# FCU Monitoring Interface 3days Mon 3/28/05 Wed 3/30/05
23 [# Integrate & Test 3days Thu3/31/05 Mon 4/4/05 —y
25 @ Flight Control Unit 10 days Mon 2/14/05 Fri 2/25/05 P—
27 [+ Data Archive Unit 10days Mon3/7/05  Fri318/05 P—
29 Data Archive Disk 3days Mon 3/21/05 Wed 3/23/05 l o 4
31 | [# Auxiliary Transmitter 5days Thu 3/24/05 Wed 3/30/05 P—
33 | [# Mechanical Structure 10days  Tue 4/5/05 Mon 4/18/05 P—
35 |+ Thermal Control 5days Tue 419/05 Mon 4/25/05 P—
37 |[# System Integration & Test 6days Tue 426/05  Tue 5/3/05 P—
| IE |# Management | 75days Mon 12405 Fri 5/6/05 [ _— .
=i« i 2l L ;I:I
Ready f
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Make an image for documents

To make a GIF image that can be inserted into documents, first arrange the chart and task info boundaries to display just what you want.
From the “Edit” menu select “Copy Picture”
Select “To GIF image file:” and enter a filename for the image

Copy Picture @) < Select what to copy: Rows

S e on screen or Selected Rows
2ol o  Seclect the timescale as either
[FourselPoject Managenertiectrs SEsanpl Popataf _Browse.. | what is shown on the screen
v or for specific dates

(" Selected rows

T e Click OK and the image will
G e be generated.

¢ From:  [Sun 1/9/05 v o [Sun 5/a/05 ~

| OK I Cancel I
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Final version of project

* Below is the GIF image of the example project ready to be inserted in a
document.
| February | March I April May
ID |Task Name 18 [1m6 [ 123 [130 | 28 [ 2m3 [ 220 [ 227 [ 3 [ 313 [ 320 [327 [ 43 [ 4n0 [ 417 [ 424 | 51 | 58
1 Power System e —————————————
2 Power Source L o
4 FCU Supply o
6 DAU HD Supply Ty i
8 DAU Supply : ety :
10 CubeSat Supply
1" Interface to power source
13 FCU Control Interface i
14 Establish Cortrol Reguirements H
15 Design control interface {
16 Prototype & test design :
17 Complete design ’ i :
18 Implement & test design :
19 DC/DC Converters :
21 FCU Monitoring Interface
23 Integrate & Test I e
25 | Flight Control Unit P——
27 | Data Archive Unit i ; Pp——
23 | Data Archive Disk : Py ?
31 |Auxiliary Transmitter i P—
33 |Mechanical Structure : P——
35 |Thermal Control P—
37 |System Integration & Test i P——
33 |Management )
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